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To navigate to PowerTeacher: 

Quick User Guide 

Using PowerTeacher Pro 
PowerSchool's new gradebook, PowerTeacher Pro, includes new 

functionality for managing the classroom, including advanced 

features for both standards-based and traditional grading. 
 

 

 

 

 

Accessing the Gradebook 

You can navigate to PowerTeacher Pro directly through the 

PowerTeacher main page. There’s no need to launch a separate 

application to access the gradebook. The first time you navigate to 

the gradebook, you’ll see a welcome message that introduces some 

of the features. (See diagram to the right) 

1. Enter the URL of the PowerSchool server or select the link for 

PowerTeacher from the DataConnect Site at 

http://web1.nbed.nb.ca/sites/dataconnect/Pages/default.aspx 

2. Enter your username and password 

3. Click Sign In 

4. On the Start Page, click PowerTeacher Pro (from the left 

menu) 

5. Read the welcome message and click Close (you can always 
review the welcome message again by clicking on the “?” 

symbol and then click “Getting Started”) 
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Viewing and Adding Class Descriptions 

PowerTeacher Pro includes details about each class you teach, such 

as the course name, course number, section number, period, term, 

start date and end date. Add more details about the class, such as 

a description or the syllabus,that will be visible in the PowerSchool 

Student and Parent Portals (This applies to schools using the 

Parent Portal option). 

To add a class description: 

1. At the top of the gradebook window, select a class 

2. In the upper-right corner, select the term in which the class 

meets, if different from the current term 

3. Click Class 

4. Select Class Descriptions 

 
The details pane for the selected class opens. 

5. Enter the class description, syllabus, or other details in the 

Description field (You can copy/paste information from any 

document into this area) 

6. Click the arrow to the left of another class name to open the 

details pane and add a description 

7. Click Save 

 

Setting Up Display Preferences 

You can customize the display settings to control how class names 

appear in your gradebook—by period and day, by section number, 

or alphabetically. Additionally, define whether or not to show 

standards and traditional grades. 

To set up display preferences: 

1. Click Settings 

2. Select Display Settings 

3. Open the "Display and Sorting" menu and select an option, 

such as Section Number (sort by Course Name), to 

change the way class names appear 

4. Check Show Standards Pages and Links to use the 

standards grading features in the gradebook 

5. Check Show Standards on Assignments to show 

standards aligned to assignments in the gradebook 

6. To change the sort order of the Traditional and Standards 

navigation links in the Grading menu and Quick Menu, open 

the Navigation Links Sort Order menu and choose 

Standards, Traditional 

 
The default setting is Traditional, Standards. 

7. To display the Professional Judgment Indicator on the 

Standards and Standards Progress pages, check Show on 

Grading: Standards and Show on Students: Standards 

Progress 

8. Check Show Traditional Grade on PowerTeacher Pro 

Screens to display traditional grades in the gradebook 

9. Then from the “Values to Show in the Traditional Grade 

Column” menu, select the types of grades you want to see, 

such as Grade, Percent, and Points 

10. Under Student Names, use the Display menu to define how 

students’ names will appear in the gradebook, such as by 

first, then last name 

11. Use the “Sort Students by” menu to choose how to sort the 

lists of students, such as by first name 

12. To view new students’ names at the bottom of class lists, 

check Add newly enrolled students to the bottom 

13. To conceal the names of pre-registered students from class 

lists, check Hide pre-registered students 

14. Click Save 
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Setting Up Grading Preferences 

Teachers may define some of the grade calculations for the 

classes they teach. 

To define a traditional grade calculation for a class: 

1. Click Settings 

2. Select Traditional Grade Calculations 

3. To see the grade calculations for all of the classes, click 

Expand All 

4. For one of the classes in the list, click the Edit icon next to 

the first reporting term 

5. To calculate the overall class grade using the formula, verify 

that Calculate Overall Class Grade is checked 

6. Open the Type menu and choose a calculation type, such as 

Category Weighting 

7. Open the Attribute menu and select a category, such as 

Products 

8. To define the weight of the selected category, enter a value 

in the Weight field, such as 2 (for 20%) 

9. To include another category, click the + sign 

10. Open the Type menu and choose Category Weighting 

11. Open the Attribute menu and select a different category, 

such as Observations 

12. To define the weight of the selected category, enter a value 

in the Weight field, such as 3 (for 30%) 

13. Repeat steps 13-16 to set up weighting for two more 

categories 

 

Use weight values that will make the values in the Percent 

columns add up to 100%. 

14. To save the grade calculation, click Save 

 
Set up the grade calculations for the remaining reporting 

terms.  

 

To define standards grade calculations: 

1. Click Settings 

2. Select Standards Grade Calculations 

3. Define how standards grades will be calculated from 

assignment scores by default, for example, choose Most 

Recent Scores 

4. Define the number of recent scores to include in the 

calculation and their relative weighting by clicking Edit, 

choosing the number of scores, and modifying the values in 

the Weight column 

5. To automatically calculate higher-level standards grades 

from lowest-level standards grades, check Auto-Calculate 

6. Select the metric that will be used in the calculation, such 

as Mean 

7. Click Save 
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Working with Assignments 

Before you begin creating assignments, it’s recommended that you 

create categories so you can group assignments by type. Then, set 

up assignments in the gradebook, choose whether or not to include 

them in the final grade, and associate strands and/or outcomes to 

them.  

 

Creating Categories 

All Districts (ASDE,ASDW,ASDS,ASDN) have created predefined 

categories for all teachers K-12(see diagram below). These 

categories are Conversations, Observations, Products and General 

Information.  You have the choice to use your own categories, or 

use district-created categories. District-created categories are 

identified by an icon that looks like a school house next to the 

category name. 
 

 

To create an assignment category(From the main PowerTeacher 

Pro screen): 

1. Click Create 

2. Select Category 

3. On the Category tab, open the Select Classes menu and 

select the class or classes in which you will use the category 

4. Enter the name of the category, such as Test 

5. Select a color for the category, such as Red 

6. Use the default status of Active 

 
Check Inactive when you want to make categories that you 

no longer use inactive. 

7. Enter a description of the category, such as Use for test 
assignments 

8. Click the Assignment Defaults tab 

9. Select the default score type that assignments in this 

category will use, such as Points 

10. To include extra points in the assignments by default, click 

Extra Points and enter the number of extra points, such as 
5 

11. To weight assignments in this category by default, click 

Weight and enter a value, such as 2, in the Weight field 

12. In the Score Entry Points field, enter the number of points 

that assignments in this category will be worth by default, 

such as 100 

13. To include assignments in this category in final grade 

calculations by default, verify that Count in Final Grade is 

selected 

14. To save the new category, click Save 

 

Creating and Viewing Assignments 

You can view assignments on both the Assignments and 

Scoresheet pages. Set up assignments at the beginning of a school 

term or at any time during the term. To save time, copy 

existing assignments or create duplicates while creating a 

new assignment. 
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1. To create an assignment click CREATE 

2. Select Assignment 

3. Open the Select Classes menu and select a class 

 
Click outside the Select Classes menu to close it. 

4. Enter the name of the assignment, such as Unit 1 Test 

5. Select Test as the category 

6. Select a score type, such as Points 

7. Enter the number of score entry points, such as 80 

8. To include the assignment in students’ final grades, verify 

that Count in Final Grade is selected 

9. Enter the assignment due date 

 
The default due date is today’s date. 

10. Enter a description, such as This test covers all of the 

topics in Unit 1 

11. Click the Students tab 

12. Verify that the assignment applies to all students 

 
To apply the assignment to a selection of students, click 

Add/Remove Students. Then clear the check box next to 

the Filter area and check the boxes next to the selected 

students’ names. 

13. Click the Standards tab 

14. Select the standards that are aligned to the assignment 

15. Click the Publish tab 

16. Open the Publish Assignment menu and choose when to 

publish the assignment for students and parents 

17. To publish students’ scores once you’ve scored the 

assignment, check Publish Scores 

18. Click Save at the bottom of the Create window 

 
At this point, you could copy the assignment by clicking 

Duplicate at the bottom of the Create window or close the 

window by clicking X in the upper-right corner. 

To duplicate an assignment for use in another class: 

1. Click Grading 

2. Select Assignment List 

3. In the list of assignments, locate an assignment that you’ve 

already created and click the Edit icon 

4. Click Duplicate at the bottom of the Edit window 

5. Open the Select Classes menu, clear the check box next to 

the currently selected class, and choose a different class 

 

Click outside the Select Classes menu to close it. 

6. Enter the assignment name, such as Unit 1 Test 

7. Use the same category, score type, score entry points, due 

date, description, and publication settings as the original 

assignment, or modify the values as needed 

8. Click the Standards tab 

9. Click Add/Edit Standards and, if needed, select a new set 

of standards that are aligned to this assignment 

10. Click Save and close the Edit window 

11. To verify that you copied the assignment to a different 

class, click the name of the currently selected class in the 

navigation bar at the top of the page and select the class 

that you copied the assignment to 

12. Locate the duplicated assignment in the list of assignments 
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Marking  Assignments 

Use one of two methods to score an assignment—score a single 

assignment from the Assignments page, or score multiple 

assignments on the Scoresheet. 

To enter scores, score indicators, or comments for a single 

assignment: 

1. Click Grading 

2. Select Assignment List 

3. Click the name of an assignment 

4. Click in a student’s score cell and type a score, such as 72 

 

View the assignment summary above the list of students to 

see which score type to use. 

5. Click the Comment icon in the Score Inspector 

6. Enter a comment, such as Needs to turn work in on 
time 

7. Click the right-facing Score arrow in the Score Inspector to 

move to a standards score cell (if standards are aligned to 

the assignment) 

8. Enter a standards score for the student 

 
View the assignment summary above the list of students to 

see which grade scale type to use. 

9. Click Save 

To enter scores, score indicators, or comments for one or more 

assignments on the Scoresheet: 

1. Click Grading 

2. Select Scoresheet 

3. Click in a student’s blank score cell for the selected 

assignment and enter a score in the Score Inspector

Click the vertical Fill icon to fill all of the blank score cells 

with the score you entered in the Score Inspector 

4. In the alert window that lists the number of scores that 

were filled, click Ok 

5. Click in a different student’s score cell for a different 

assignment and click the Exempt score indicator 

6. Click Save 

When you delete or edit a score, the values in the student’s Course 

Grade column are grayed out because they are being edited. Once 

you click Save, the student’s grades will be recalculated using the 

new score. 

 

Working with Final Grades 

Final grades are updated automatically throughout the term as you 

enter assignment scores in the gradebook. When the term comes 

to a close, however, you may have additional tasks to perform 

before submitting grades for report cards to make sure that your 

final grades are accurate. For example, you may have to enter 

standards grades and modify individual scores. Occasionally, you 

may also need to modify a student’s final grade in a course based 

on effort, participation, or other performance factors. 

To work with final grades, click Grading and use the links in the 

Grades section. Access the same links through the Quick Menu— 

the arrow next to the heading at the top of the grading pages. 
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7. Click Save 
 

 

 

 

 

 

 

 

 

 
To modify a final grade: 

1. Click Grading 

2. Click Traditional 

3. Click a student’s final grade 

4. In the Score Inspector, edit the student’s grade 

 
For example, change a percentage of 91 to 94. 

5. Click Save 

 
Notice that the student’s final grade cell has a small triangle 

in the upper-left corner, which indicates that the grade has 

been modified manually. 

 

 

 

To revert to the calculated grade, click the Undo icon in the 

score inspector 

 

 
 

Recalculating Final Grades 

Although final grades in PowerTeacher Pro are calculated 

automatically, you can force a recalculation, if necessary. Use the 

recalculate tool after making significant changes in the gradebook, 

such as adding multiple assignment scores for students who 

transferred from another class. Also, recalculate grades when your 

PowerSchool administrator changes a setting that affects the 

gradebook, such as the grade calculation formula. 

To use the recalculate tool: 

1. Click Settings 

2. Select Recalculate Final Grades 

3. Select the classes in which you are recalculating grades 

4. Check Traditional Final Grades 

5. Click Recalculate 
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Analyzing Class Progress 

To analyze the performance of an entire class, begin by selecting 

the class at the top of the PowerTeacher Pro window. Then, click 

Progress. Depending on how the gradebook is set up, you can 

view class progress on traditional grades and standards grades. 

Viewing Traditional Grades Progress 

To view traditional grades progress: 

1. From the Progress menu, select Traditional 

 
The graph on the Traditional Grades Progress page shows 

the distribution of grades for the class for the selected 

reporting term. To the right of the graph, view a summary 

of the total number of students who have missing, late, or 

incomplete assignments. 

 

 

2. Click the graph to open the Traditional Grades Distribution 

window 

3. On the left side of the Traditional Grades Distribution 

window, view the score distribution for each reporting term 

in the school year 

4. On the right, view the grade trends of the students in the 

class for the selected term, compared to the previous term 

 

A red arrow in the Grade column indicates that the student’s 

grade is trending down between the selected terms. A green 

arrow indicates an upward trend, while no arrow indicates 

no change. You can see which students are performing 

better or worse between terms. 

5. To compare trends between a different selection of 

subsequent terms, click a term in the Score Distribution 

column 

 

6. To close the window, click X in the upper-right corner 
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Viewing Standards Grades Progress 

To view standards grades progress: 

1. From the Progress menu, select Standards 

 
The graph on the Standards Progress page shows the 

distribution of grades for each standard aligned to the 

course, for the selected class and reporting term. 

 

 

2. On the right side of the Standard Grades Distribution 

window, click the score distribution for the selected 

standard and view data for each reporting term in the 

school year. 

3. To compare trends between a different selection of 

subsequent terms, click a term in the Grade 

Distribution column for T1, T2 or T3 

4. To close the window, click X in the upper-right corner 
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Running PowerTeacher Pro Reports 

The gradebook contains reports that you can view onscreen or 

print. Personalize each report by entering a custom title or by 

including a top note, bottom note, or signature line. The following 

table provides brief descriptions of the reports: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

To run the Individual Student Report: 

1. Click Reports 

2. Select Individual Student Report 

3. Enter a report title, such as Progress Report 

4. Open the Select Classes menu and choose the classes to 

include on the report 

Report Name Description 

Multi-Function 

Assignment Report 

 Use this report to view or print a 

list of students and scores per 

assignment 

 Use it to find missing, late, or 

incomplete assignments, to help 

students and parents keep up with 

class work, to target students who 

need extra help, or to gauge 

which assignments present the 

most challenges to students 

Student Roster  Use this report to view or print 

demographic information by class 

 Use the report, for example, to 

keep track of money collected for 

classroom field trips, or as an 

emergency contact list 

 Customize the report by adding 

blank columns (the report 

remembers the information you 

entered last) 

 Use the Order arrows to arrange 

the columns in any order 

 

Report Name Description 

Individual Student 

Report 

 Use this report to view or print a 

summary of the class activity per 

student 

 Present a summary of student 

work to parents at conferences or 

to a principal during a review, or 

use the report as a midterm 

update for students and parents 

 Choose whether or not to include 

course grades and attendance, 

assignments, category totals, and 

comments 

 Print the report for a few students 

or a group 
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5. To run the report for a selection of students rather than for 

all of the students in the classes, click Add/Remove 

Students 

6. All of the students are selected by default, so clear the 

check box to the right of the Filter area, then in the list of 

students, check the boxes next to individual student’s 

names 

7. In the Sort Options section, open the Layout menu and 

choose By Section, By Student 

8. To sort the report by students’ last names, open the 

Students menu and choose Last Name 

9. Verify that Show Percentages is selected to include 

students’ grade percentages in the report 

10. Open the Data To Include menu and check Course Grade 

Comments and Assignment Comments to include any 

comments that you’ve entered about the students in the 

report 

 
"Course Grades and Attendance," Assignments, and 

Category Totals are checked by default. 

11. Click the Data To Include menu again to close it 

12. To include students’ grades from the current term, use the 

default settings under Date Range 

13. Scroll to the top of the page and click the Format tab 

14. Since you are including all of the available data in the 

report, leave the page orientation set to Landscape to 

make the text easier to read 

15. Use the default option PDF for the report output 

16. To create a page break between students, check Page 

Break 

17. Choose to exclude row shading to save ink during printing 

18. Leave the “Include” check box clear for the Top Note option, 

since you don’t plan to include a note at the top of the 

report 

19. Leave the “Include” check box clear for the Bottom Note 

option, since you don’t plan to include a note at the bottom 

of the report 

20. To generate the report, click Run Report 

To run the Student Roster report for a class: 

1. Open the menu at the top of the gradebook window and 

select a class 

2. Click Reports 

3. Select Student Roster 

4. Enter a report title, such as Field Trip Roster 

5. Since you selected a class before you navigated to the 

Reports menu, it is already selected for the Classes option 

6. Verify that the report applies to all of the students in the 

selected class 

7. To sort the roster of students by last name, open the 

Students menu and choose Last Name 

8. Add columns of student information by opening the Add 

Columns menu and clicking Add next to Gender and Grade 

Level 

9. Click Add next to Blank twice to include a column for taking 

attendance and one for tracking participation 

 
A column titled “Name” is included by default to list the 

students’ names. 

10. Click the Add Columns menu again to close it 

11. Enter Attendance as the title of the first blank column 

12. Enter Participation as the title of the second blank 

column 
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13. Scroll to the top of the page and click the Format tab 

14. Open the Orientation menu and choose Portrait 

15. Use the default settings for the rest of the format options 

16. To generate the report, click Run Report 
 

 


